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CHAPTER 1

Introduction
The installation of Pulse depends on multiple applications and utilities working together. There are a
couple of types of deployment you can use, and you can install Pulse on one of three different oper-
ating systems. The installation type that you choose will depend on factors that are specific to your
environment, such as the number of users you plan to host, your web usage, and other factors
related to deploying an SQL database and IIS server.

This guide discusses how to install Pulse on Windows Server 2012.

This chapter discusses the following:

Two-Server Deployment 7

Single-Server Deployment 8
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Two-Server Deployment
The most common deployment type for Pulse is to install the components in a distributed envir-
onment on two servers:

n Pulse Web Server The web server is a Windows Server system running Microsoft Internet
Information Services (IIS). You install the Pulse server application on this system.

n Pulse Database Server The database server is a Windows Server system running Microsoft
SQL Server. You install an instance of Microsoft SQL and create the Pulse database on this
system.

After deploying Pulse, the integrated Flare output can be published either to the Pulse web server or
to a different system with access to the Pulse web server.
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Single-Server Deployment
It is also possible to install all of the Pulse components on a single server. This means the Pulse web
server and database server are running on a single system. Although this is a simple way to deploy
Pulse, most organizations choose to install Pulse in a distributed environment because it offers
greater scalability and performance.

After deploying Pulse, the integrated Flare output can be published either to the Pulse web server or
to a different system with access to the Pulse web server.

IMPORTANT: When deciding which installation type is best for your environment, it is
recommended that you discuss your options, deployment strategy, and system require-
ments with your IT department.
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CHAPTER 2

Requirements
As you prepare for your Pulse installation, familiarize yourself with the minimum system require-
ments.

This chapter discusses the following:

Pulse Web Server 10

Pulse Database Server 13

Required Access Credentials and Networking Information 16
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Pulse Web Server
The Pulse web server provides users the ability to access and use the web-based user interfaces of
the Pulse system.

WEB SERVER—MINIMUM HARDWARE REQUIREMENTS

This table details the minimum hardware requirements for the Pulse web server:

Component
Minimum Requirement (for a Pilot

Server)
Recommended (for a Production Server)

Processor 32-bit, quad-core 64-bit, quad-core

Memory 4 GB 4 GB 

Hard Disk 100 GB (for data drives)

80 GB (for system drives)

For daily operations, maintain at least
twice as much free space as RAM.

100 GB (for data drives)

80 GB (for system drives)

For daily operations, maintain at least
twice as much free space as RAM.
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WEB SERVER—OPERATING SYSTEM REQUIREMENTS

This table details the operating system requirements to install the Pulse web server:

The Pulse setup program installs the Pulse application on the web server (this is the server running
IIS). Before running the setup program, you must make sure Microsoft .NET Framework 4.5 is
installed.

IMPORTANT: All of the latest Windows service packs and critical updates must also be
installed.

Requirement Notes

Microsoft Win-
dows Installer
(MSI) 5.0

The MSI 5.0 is included with the operating system.

Internet Inform-
ation Services
Version 8

This is included with the operating system. Use the Server Manager to add the
Web Server (IIS) role service.

ASP.NET 4.5 This is included with the operating system. Use the Server Manager to add the
ASP.NET role service. This is covered in the steps for installing IIS.

Microsoft
.NET Framework
4.5

This is included with the operating system and may already be installed on
your server, typically by a Network Administrator. If it is not installed, you can
download it from:

http://www.microsoft.com/en-us/download/details.aspx?id=30653
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WEB SERVER—PULSE SETUP PROGRAM

The Pulse setup program installs the Pulse application on the web server (this is the server running
IIS). Before running the setup program, you must make sure Microsoft .NET Framework 4.5 is
installed.

WEB SERVER—MICROSOFT VISUAL C++ 2010 REDISTRIBUTABLE

The Pulse setup program requires the web server to be running the Microsoft Visual C++ 2010 Redis-
tributable or a newer version.

This prerequisite is automatically installed when you run the Pulse setup program. The setup pro-
gram automatically checks your system for a compatible version. If a compatible version is detec-
ted, you can quit the system check. If a compatible version is not detected, you will be prompted to
download and install it. See "Installing and Activating Pulse" on page 51.

IMPORTANT: Software vendors commonly redistribute different versions of Visual C++
with their programs. If your system is running more that one version of Visual C++, you do
not want to delete or uninstall any version from your system as doing so can render any
linked software programs inoperable.

WEB SERVER—RECOMMENDED BROWSERS

For best results, it is recommended that you use one of these web browsers when accessing the
web-based Pulse tools:

Browser Version

Microsoft Internet Explorer 7 or later

Apple Safari 5

Mozilla Firefox 3.5 or later

Google Chrome 5.0 or later
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Pulse Database Server
The Pulse database server is the primary repository for Pulse data. This includes users, groups, files,
messages, videos, and images.

DATABASE SERVER—MINIMUM HARDWARE REQUIREMENTS

This table details the required hardware components for the Pulse Database server:

Component Minimum Requirement (for Pilot)
Recommended (for Pro-

duction)

Processor 32-bit, 4 core 64-bit, 4 core

Memory 4 GB 4 GB 

Hard Disk 100 GB (for data drives)

80 GB (for system drives)

For daily operations, maintain at least twice as
much free space as RAM.

100 GB (for data drives)

80 GB (for system drives)

For daily operations, main-
tain at least twice as
much free space as RAM.

For every 1,000 users per
year, we recommend 100
GB for storage.
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DATABASE SERVER—OPERATING SYSTEM REQUIREMENTS

This table details the operating system requirements for the Pulse database server:

IMPORTANT: All of the latest Windows service packs and critical updates must also be
installed.

Requirement Notes

Microsoft Win-
dows Installer
(MSI) 5.0

The MSI 5.0 is included with the operating system.

Internet Inform-
ation Services
Version 8

This is included with the operating system. Use the Server Manager to add the
Web Server (IIS) role service.

ASP.NET 4.5 This is included with the operating system. Use the Server Manager to add the
ASP.NET role service. This is covered in the steps for installing IIS.

Microsoft
.NET Framework
4.5

This is included with the operating system and may already be installed on
your server, typically by a Network Administrator. If it is not installed, you can
download it from:

http://www.microsoft.com/en-us/download/details.aspx?id=30653
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DATABASE SERVER—SQL SERVER REQUIREMENTS

To give end users the ability to use the Pulse search features, you must install a supported version
of Microsoft SQL Server. The edition you install must support the full-text search feature. Please
refer to the documentation provided with SQL Server to determine if that edition supports full-text
search.

IMPORTANT: Microsoft SQL Server Express Edition with Advanced Services is the only
Express edition from Microsoft that is compatible with Pulse. This is because Pulse requires
the full-text search feature.

IMPORTANT: Microsoft SQL Server Express with Advanced Services edition supports a
maximum database size of 10 GB. It is best suited when used in lab/test environments. It is
not recommended for production environments.
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Required Access Credentials and
Networking Information
The user performing the installation will also need the following information in order to complete the
installation and configuration tasks:

Item Requirements Purpose

Active Dir-
ectory
Domain
Account

Create a Domain Account with Local Administrator
Rights for the Pulse Server. This account will need:

n A password that never expires

n A valid email address in Active Directory

n Read access to Active Directory

n You should also grant this account System
Administrator (sysadmin) privileges in
SQL Server.

Used by the PulseService
on the application server
to schedule notifications,
send emails, and deliver
posts.

Used by the Web Applic-
ation Pool.

DNS Entry n Resolves to the Pulse web server

n Uses a fully qualified domain name

The URL that Pulse Admin-
istrators use to access
the Pulsedashboard.

Outbound
Email Set-
tings
(SMTP Relay)

Port 25 (typical, depends on your network) Gives Pulse the ability to
send outbound email mes-
sages.

Inbound
Email Set-
tings

To enable reply-to email capabilities, you will need
settings for one of the following:

n POP3 host, username, and password

OR

n Exchange Web Services URL,domain, user-
name, and password for the Microsoft
Exchange account

OR

n SMTP Drop Folder

Required by Pulse web
server to provide reply-to
email capabilities.
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Item Requirements Purpose

SSL Cer-
tificate for
Pulse Web
Server
(Optional)

If you plan to use the Secure Sockets Layer (SSL)
protocol to establish an encrypted connection with
your Pulse site, you must obtain an SSL certificate
from an SSL provider and install it on the Pulse web
server.

Gives site visitors the abil-
ity to access your site
using the secure https://
protocol.

Use the Internet Inform-
ation Services
(IIS) Manager to install
the SSL Certificate.
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CHAPTER 3

Installing the Prerequisites
Information for Network Administrators

To prepare for a Pulse installation, you need to prepare the systems that will be hosting the Pulse
server application and the Microsoft SQL Server instance for the Pulse database.

This chapter discusses the following:

Before You Begin 19

Installing the Prerequisites 20
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Before You Begin
In order to download and install the prerequisites, you need an Internet connection.

You also need the ability to log on the server(s) as a user who has access permissions to install soft-
ware and change configuration settings on the system. This requires you to have access cre-
dentials for one of these accounts:

n The Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who installed
the server's operating system for the user name and password.

OR

n A Local User Account with Administrative Privileges If available in your environment, you can
use a local administrator account. With a local administrator account, the server checks its
own files to authenticate the user and determine if they have the appropriate administrative
rights to install software on the system. This account is created on the server, typically by a
Network Administrator.
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Installing the Prerequisites
First, install Windows Server 2012 on the system acting as the Pulse web server and Pulse database
server. Whether you are setting up a new server or just using an existing Windows server, you should
also ensure that the operating system is updated with all of the latest service packs, critical
patches, and security updates from Microsoft.

If you are not familiar with how to install a server operating system, contact your Windows Admin-
istrator and/or Network Administrator for assistance. This will help to ensure that your server is in
compliance with any security and network requirements specific to your environment.

IMPORTANT: If you are not familiar with how to install a server operating system, contact
your Windows Administrator and/or Network Administrator for assistance. This will help to
ensure that your server is in compliance with any security and network requirements spe-
cific to your environment. See "Requirements" on page 9.

CHAPTER 3  20



HOW TO INSTALL IIS

IIS provides the server hosting Pulse with web server capabilities and the ASP.NET framework,
which is a feature of the .NET Framework. It supports the creation of web pages and web services.
If you are setting up a new web server for Pulse, it is very important that you install IIS before
installing the .NET Framework.

IMPORTANT: Alwaysmake sure that you are installing IIS on the system designated as
the Pulse server. If you are setting up a new server, IIS must always be installed before the
.NET Framework.

IMPORTANT: Do not run IIS on a domain controller or a backup domain controller.

NOTE: IIS is a built-in component of the Windows OS. For Windows Server 2012, the
OS lets you install IIS 8.0.

1. Log in to the system that you selected to be the Pulse web server using one of these
accounts:

n Built-in Administrator Account for Windows Server This account has full administrative
privileges and is included with the operating system by default. See the person who
installed the server's operating system for the user name and password.

OR

n A Local User Account with Administrative Privileges If available in your environment, you
can use a local administrator account for the server. With a local account, the server
checks its own files to authenticate the log in and determine if the user has the appro-
priate administrative rights to install software on the system. This is different from a net-
work domain account.

2. Determine if IIS is installed on the operating system. To do this, press the Windows key on
your keyboard.

Click the Server Manager tile to open the Server Manager.
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If IIS is installed, this should be indicated on the Server Manager.
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3.   If you need to install IIS on the server, add the Web Server (IIS) role service:

a. In the Server Manager, click Add roles and features.

The Add Roles and Features Wizard opens.

b. Click Next..
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c. Make sure Role-based or feature-based installation is selected. Then click Next.

The local server should be listed.

d. Click Next.. The list of roles is shown.
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e. Scroll down and place a check mark in the Web Server (IIS) box.
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A dialog opens.

f. Click Add Features.

The Web Server (IIS) check box now has a check mark.

g. Click Next.

By default you should see options for .NET 3.5 and .NET 4.5. Only the option for .NET 4.5
should be selected.

h. Scroll down and select Windows Identity Foundation 3.5.

i. Click Next..

j. Click Next again.

k. Place a check mark next to all of the role services in the list below. When finished, click
Next.
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Select the desired services using the recommended role services listed below. Role ser-
vices required by Pulse are marked with an asterisk (*).

Role Services Category Select These Role Service Check Boxes

Common HTTP Features *Static Content

Default Document

Directory Browsing

HTTP Errors

Application Development *ASP.NET 4.5

.NET Extensibility 4.5

ISAPI Extensions

ISAPI Filters

Health and Diagnostics HTTP Logging

Security *Basic Authentication

*Windows Authentication

Request Filtering

Performance Static Content Compression

Dynamic Content Compression

Management Tools IIS Management Console

IIS 6 Management Compatibility *IIS 6 Metabase Compatibility

l. Confirm your selections and click Install

m. After the installation finishes, click Close
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CHAPTER 4

Installing Microsoft SQL Server
Information for Network Administrators

You can install a Microsoft SQL Server instance to use as the Pulse database. This instance can
reside on the Pulse web server (this is the server running IIS) or on a different system with access to
the Pulse web server.

This chapter discusses the following:

Before You Begin 31

Installing SQL Server 32
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Before You Begin
To begin the installation, log in to the server where you will be installing the SQL database instance.
You must use the appropriate access credentials:

n Built-In Administrator Account for Windows Server This is the account that lets you run pro-
grams as an administrator, before a user account is created.

OR

n Windows User Account with Local Administrator Privileges This account must have local
administrator privileges for the server.
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Installing SQL Server
You must install a supported version of Microsoft SQL Server:

n Microsoft SQL Server 2012

n Microsoft SQL Server 2008R2

n Microsoft SQL Server 2008

You can use a full or express version of any of these, but the full version is recommended because it
can store more data.

Regardless of your operating system (Windows Server 2012, 2008R2, or 2008), you should be able to
use any of the versions of Microsoft SQL Server listed above. Following are general steps for all
three. For the most part, the steps are identical for each, though there may be some minor vari-
ations.

It is recommended that you apply all available service packs and critical updates to your operating
system prior to the installation.

IMPORTANT: If you are running Windows Server 2012 or are installing Microsoft
SQL Server 2012, be sure you have the most current version of Pulse. Microsoft SQL Server
2012 and Windows Server 2012 are not compatible with earlier versions of Pulse.
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HOW TO INSTALL MICROSOFT SQL SERVER

1. Obtain the installation media.

2. Log in to the server as an administrator.

3. Run the setup program from a CD or the network.

IF YOU ARE INSTALLING FROM A NETWORK

If the Do You Want to Run This File dialog appears, click Run.

If prompted by Windows User Account Control message asking if you want to allow the pro-
gram to make changes to this computer, click Yes.

Depending on your specific environment, you may also be prompted for access credentials
to access the setup program on your network share.

4. For SQL Server 2008: If you are performing the installation on a system Windows Server 2008
R2, the Program Compatibility Assistant appears. Read the message and then click Run Pro-
gram.
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5. In the Planning page of the Installation Center, review the information. When ready to pro-
ceed, click Installation in the left pane.
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6. For SQL Server 2008 R2 In the Installation page, click the New installation or add features to
an existing installation option.

For SQL Server 2008 and 2012 In the Installation page, click the New SQL Server stand-alone
installation or add features to an existing installation option.

If a dialog opens with a security warning, click Run.

The wizard checks the system to detect potential issues.
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7. In the Setup Support Rules dialog, do one of the following:

n If the wizard finds any failed, warning, or skipped rules, click Show Details and/or click
View detailed report. Any failures must be resolved before proceeding. When resolved,
click Re-run to perform another system check.

OR

n If wizard determines that the system passes the system check, click OK.

The wizard ensures that you have a valid product key.
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8. In the Product Key page, validate the SQL Server instance:

a. In the Product Key page, select the Enter the product key option.

b. Type your Microsoft license key in the box.

c. Click Next to open the License Terms page.

d. Place a check mark in the I accept the license terms box.
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e. (Optional) If you wish to send feature usage data, select the check box at the bottom of
the dialog.

f. Click Next. (If your system requires updates, you may see a page at this point showing
available updates. You can click the check box to include updates in the installation and
click Next.)

g. Depending on the version of SQL Server, you may need to click Install at this point. The
setup program performs a system check to detect potential issues.
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9. In the Setup Support Rules page, do one of the following:

n If potential issues are found, click Show Details. You can also click View detailed report
for more information. Issues must be resolved before proceeding. When resolved, click
Re-run to perform another check.

OR

n If the Setup Support Rules indicates the system has passed, click Next.

10. In the Setup Role page, choose the appropriate installation type. Then click Next to proceed.

HOW TO CHOOSE AN INSTALLATION TYPE

If you are not familiar with SQL Server, it is recommend that you choose the following:

a. Select SQL Server Feature Installation. This lets you choose the features to install.

b. Click Next to open the Feature Selection page.
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11. In the Feature Selection page, place check marks next to the desired features. Then click
Next.

HOW TO INSTALL THE MINIMUM REQUIRED FEATURES

At a minimum, you should:

Use the default shared feature directory.

a. Select these check boxes:

n Database Engine Services

l SQL Server Replication

l Full-Text Search or Full-Text Search and Semantic Extractions for Search

n Management Tools - Basic

l Management Tools - Complete

n SQL Client Connectivity SDK

SQL SERVER 2008/2008R2 EXAMPLE
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SQL SERVER 2012 EXAMPLE

b. Use the default shared feature directory.

c. Click Next.

The setup program checks the system for potential issues. 

12. In the Installation Rules page, do one of the following:
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n If any issues are found, click Show Details. You can also click View detailed report for
more information. Issues must be resolved before proceeding. When resolved, click Re-
run to perform another check.

OR

n If all of the system configuration checks have passed, click Next.

The Instance Configuration page opens.

13. In the Instance Configuration page, select one of these buttons:

n Default instance If this is the first time SQL Server instance is being installed on the sys-
tem, use the default instance name. This is typically MSSQLSERVER.

OR

n Named instance If you do not want to use the default instance, select this button and
type a unique name in the Instance ID box. For example, type PULSE01.
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14. Click Next to open the Disk Space Requirements page and then:

n If your system does not meet the disk space requirements, review the Disk Usage Sum-
mary and address any issues before proceeding.

OR

n If your system meets the disk space requirements, click Next.

15. In the Server Configuration page, under the Service Accounts tab you must provision service
accounts to each listed SQL service. When finished, click Next.
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HOW TO PROVISION SQL SERVICE ACCOUNTS

IMPORTANT: Always contact your SQL Server Administrator and/or Windows
Administrator for the appropriate service accounts to use in your environment.

a. Provision the appropriate accounts to the list of SQL services.

b. Make sure the Startup Type for each service is set as follows, depending on the version
of SQL Server:

Service Account Name/Password Startup Type

SQL Server
Agent

SQL Server 2008/2008R2 There is no default account
for this service. The account you use depends on
your security requirements.

SQL Server 2012 This account defaults to NT Ser-
vice\SQLAGENT$[Name of Instance].

There is no default account for this service. The
account you use depends on your security require-
ments.

Automatic

SQL Server
Database
Engine

SQL Server 2008/2008R2 The account you use
depends on your security requirements.

SQL Server 2012 This account defaults to NT Ser-
vice\MSSQL$[Name of Instance].

The account you use depends on your security
requirements.

Automatic
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Service Account Name/Password Startup Type

SQL Full-text
Filter Daemon
Launcher

SQL Server 2008/2008R2 This account defaults to
NT AUTHORITY\LOCAL SERVICE.

The account you use depends on your security
requirements. Microsoft recommends using a low
privilege account.

SQL Server 2012 This account defaults to NT Ser-
vice\MSSQLFDLauncher$[Name of Instance].

Manual

SQL Server
Browser

The default logon account is
NT AUTHORITY\LOCAL SERVICE.

You will typically keep this setting.

Automatic

SQL SERVER2008 EXAMPLE
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SQL SERVER 2008R2 EXAMPLE

SQL SERVER 2012 EXAMPLE
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16. In the Database Engine Configuration page, under the Account Provisioning tab (SQL Server
2008/2008 R2) or the Server Configuration tab (SQL Server 2012), choose one of these
options:

n Windows authentication mode If you choose this option and are not logged in as an
administrator, it is recommended that you add an account that has sufficient per-
missions to perform all of the needed SQL administrative tasks. If you are logged in as an
administrator, it is recommended you also click Add Current User.

SQL SERVER 2008/2008R2 EXAMPLE
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SQL SERVER 2012 EXAMPLE
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n Mixed Mode (SQL Server authentication and Windows authentication) If you choose this
option, you must specify the password to use for the SQL Server system administrator
account.

When finished, click Next.
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17. In the Error Reporting page, select whether or not you want to send error reports to Microsoft.
This is your preference. Then click Next.

18. In the Installation Configuration Rules page, do the following:

n If there are issues, you must address them before clicking Next.

OR

n If there are no issues, click Next.

19. In the Ready to Install page, click Install. A progress indicator shows you the status of the pro-
cess.

20. When the installation is complete, you will see the "Installation Succeeded" message. Click
Close.

NOTE: If a failure occurs, troubleshooting information may be available on the
MadCap Software knowledge base at: http://kb.madcapsoftware.com/

NOTE: You may also want to check with your SQL Server Administrator about any
errors you experience during installation.
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CHAPTER 5

Installing and Activating Pulse
Information for Network Administrators

After preparing the Pulse web server and database server for the installation process, you can install
Pulse.

This chapter discusses the following:

List of Pulse Components 52

List of Windows Service Applications 53

Installing the Pulse Server Application 54

Activating Pulse 60
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List of Pulse Components
The Pulse setup program installs the following components and features on your server:

n Pulse Server Application This is the server application that you install on the Pulse web server.
Pulse Administrators use this tool to perform the initial server configuration.

n Pulse Dashboard This is the web dashboard that Pulse Administrators use to view different
configuration settings and to manage the embedded discussion forms in the output.
Registered users can access the dashboard using the Pulse URL.

n Community Tab and Embedded Discussion Forms This is the Community tab (optional) and
the embedded discussion form that integrates with your published Flare output. It gives users
the ability to share knowledge and expertise by posting status updates, asking and responding
to questions about topics, creating articles, and more.
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List of Windows Service Applications
Pulse runs the following Windows service applications:

n MadCap Pulse Management Service This service supports the Pulse application.

n Pulse Service This service also supports the Pulse application.

n RabbitMQ This service supports communication between IIS and SQL Server. It also monitors
the amount of RAM on the server. When free space becomes low, this service raises alarms
and block connections for the server.
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Installing the Pulse Server Application
Do the following on the web server (this is the server running IIS):

HOW TO INSTALL THE PULSE SERVER APPLICATION

1. Install the prerequisite software.See "Installing the Prerequisites" on page 18.

2. Install a Microsoft SQL Server instance for the Pulse database. See "Installing Microsoft
SQL Server" on page 30.

3. Obtain the installation media and a license code from MadCap Software:

n CD Insert the installation CD.

n Online Download the setup program using the link that you received from MadCap Soft-
ware. .

NOTE: You can obtain the Pulse license code from your MadCap Software Sales Rep-
resentative.

4. Log on to the server running IIS using an account that has administrator privileges.

5. Right-click the Pulse setup program and select Install from the context menu. This is the Win-
dows Installer Package file named "SetupMadCapPulse.msi."
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IF YOU ARE NOT LOGGED IN AS AN ADMINISTRATOR

If the Install context menu command does not appear, you are not logged in as an admin-
istrator. You can use the steps below to run the program as an administrator:

a. Navigate to the Pulse setup program. This is the Windows installer package named
"SetupMadCapPulse.msi."

b. Right-click the setup program and select Run as Administrator from the context menu.

c. If prompted by Windows User Account Control (UAC), click Yes or Continue.

d. If you are logged in with a different account, you may be prompted to enter the user
name and password for the administrator account. After entering the account inform-
ation, click Yes.

6. When the Welcome page of the MadCap Pulse Setup Wizard appears, click Next.

7. Select the I Agree option to accept the terms of the license agreement. Then click Next.

8. In the Select Installation Folder page, browse to the desired installation folder or accept the
default folder. Then click Next.

NOTE: To view a list of drives where you can install Pulse and to see the avail-
able/required space on the drives, click the Disk Cost button.

NOTE: To make the Pulse application available to any user who logs into the server,
click Everyone. To make the program available only to the logged in user account,
click Just Me.
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9. In the Confirm Installation page, click Next. A progress indicator shows the status of the pro-
cess.

IF YOU ARE PROMPTED TO INSTALL THE VISUAL C++ 2010 REDISTRIBUTABLE

If the Microsoft Visual C++ 2010 Redistributable is not installed on the server, a dialog will
prompt you to install it. Here is how you proceed through the system check:

In the Trial/Activation dialog, do one of the following in the Provide Your License Code field:

a. Place a check mark in the I have read and accept license terms box. Then click Install. A
progress indicator appears to show you the status.

b. If the following message appears, click Retry.
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c. Depending on your system, one of the following occurs:

n If you do not have the correct distributable, you will be prompted to install it.

n If the following message reappears, click Cancel. In most situations, this means the
setup program has detected a newer version of Visual C++ on your system and is
installing the required elements. The remaining steps show you how to proceed.

d. In the Installation Did Not Succeed dialog, click the log file link.
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e. In the Installation Log, place a check mark in the Verbose box.
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f. Scroll down the log and determine if the operating system is running a newer version of
the redistributable:

NOTE: If you are running a newer version of the redistributable, you do not need
to install version 2010.

g. Close the Installation Log.

h. Click Finish in the Installation Did Not Succeed dialog.

10. In the Installation Complete page, click Close..

NOTE: After completing the installation, use Windows Update to run any available
.NET Framework updates on the server. For information about Windows Update, visit this
Microsoft link: http://windows.microsoft.com/en-us/windows/help/windows-update.
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Activating Pulse
After successfully installing Pulse, you must activate the product.

HOW TO ACTIVATE PULSE

1. Log on to the server running IIS using an account that has administrator privileges.

2. Launch the Pulse server application.

HOW TO LAUNCH THE PULSE SERVER APPLICATION

n From the Desktop Hold down the Shift key and right-click to select MadCap Pulse from a
context menu. To use this method, you must be logged in as an administrator.

OR

n On 64-bit Systems Double-click the Pulse.exe file. The path to this file is C:\Program
Files\MadCap Software\MadCap Pulse\Pulse.app\Pulse.exe.

OR

n On 32-bit Systems Double-click the Pulse.exe fie. The path to this file is C:\Program Files
(x86)\MadCap Software\MadCap Pulse\Pulse.app\Pulse.exe.
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3. In the Trial/Activation dialog, do one of the following in the Provide Your License Code field:

n Type the license code that you received from MadCap Software.

OR

n Copy the license code from your download notification email and paste it into the field.A
check mark appears when you enter a valid code.

4. Click Next.

5. In the Enter Your Information page, type your name and email address in the fields provided.

6. Click Next.
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7. Select the desired activation method:

n Internet Activation If you are connected to the Internet, select this option. If you are
behind a firewall, you may need to enter your Proxy Server information.

HOW TO ACTIVATE WITH A PROXY SERVER

a. If you are behind a firewall, place a check mark in the Use Proxy Server box:

b. Enter the required proxy server and authentication information for your network.

c. Click Next.

OR

n Manual Activation To activate by email, select this option. Then enter the license code
and machine ID.

8. Click Next. 

9. Copy and paste the activation code included in the email that was sent to the provided
address.

10. Click Next.

The system activates your product.

IF YOU ENCOUNTER ACTIVATION ISSUES

If you encounter an activation issue, an error message similar to the one below appears. Take
note of the error message text as it can help you troubleshoot the issue.

Possible issues that might be encountered during the activation process include:

n Entering an Invalid License Code Try re-entering your code to make sure it was typed cor-
rectly. If you have purchased other MadCap products, make sure the code you typed is
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for the Pulse product.

n Entering a License Code that Has Already Been Activated If Pulse has already been activ-
ated on another system, you will need to deactivate it before using the license code on a
different system.

n Your System Cannot Communicate With the Activation Server The system where you are
installing Pulse is not able to communicate with the MadCap Activation Service. We sug-
gest checking your network and Internet connection and after waiting a few minutes, try
to activate the product again.

n You Must Use a Proxy Server If you are using the Internet Activation method, a noti-
fication message like the one below typically indicates that you will need to use a proxy
server to access external URLs. To obtain your proxy server information, see your Net-
work Administrator. Then try to activate your product again. If you experience an issue,
theMadCap Software knowledge base has a helpful tip about registration behind a proxy
server: http://kb.madcapsoftware.com/default.htm#cshid=GEN1004Z

The Welcome page of the Pulse Configuration Wizard appears so you can configure Pulse for first
time use. See "Pulse Server Configuration" on page 64.
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CHAPTER 6

Pulse Server Configuration
AVAILABLE TO: Administrators only

After the Pulse server application is installed on the Pulse web server, use the desktop shortcut or
the Programsmenu in Windows to start the Pulse application.

This chapter discusses the following:

Configuring Pulse for the First Time 65

Starting the Pulse Server Application 74

Setting the PulseAdmin Password 75

Pulse Server Configuration Window 76

Importing Feedback Data 85

Updating Pulse 86

Uninstalling Pulse 87
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Configuring Pulse for the First Time
After you install and activate the Pulse server application, the Welcome page of the MadCap Pulse
Configuration Wizard appears so you can perform an initial configuration.

HOW TO CONFIGURE PULSE FOR FIRST TIME USE

1. Install and activate Pulse as described in "Installing and Activating Pulse" on page 51.

2. If the MadCap Pulse Configuration Wizard is not already open, double-click the MadCap Pulse
desktop shortcut.

3. In the Welcome page of the MadCap Pulse Configuration Wizard, click Next.

4. In the Select Web Site page, do the following:

a. Select the Website for the Pulse Services Select the website on the IIS Server that will be
storing your Pulse data. By default, Pulse will use the "Default Web Site" in IIS.

b. Pulse Server URL This is the Site URL for the Pulse dashboard. Typically, it will consist of
the protocol (http:// or https://), the IP address (or the machine name), and the Pulse dir-
ectory.

EXAMPLES

HTTP:

http://<ipaddress>/pulse

http://<servername>/pulse

Secure HTTP:

https://<ipaddress>/pulse

https://<servername>/pulse

c. Click Next.
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5. In the Select SQL Server page, do the following:

a. In the SQL Server drop-down list, select Get list of SQL Servers.

If the SQL Server Browser service is turned on, the program looks for all available
SQL Servers in the Windows domain.

HOW TO TURN ON THE SQL SERVER BROWSER

If SQL Server Browser service is turned off, use these steps to turn it on:

i. Start the SQL Server Configuration Manager.

ii. Select Start > Programs. Then point to your version of SQL in the menu and select
Configuration Tools > SQL Server Configuration Manager.

iii. In the left pane, highlight SQL Server Services.

iv. Right-click SQL Server Browser and select Properties from the context menu.

v. On the Service tab, set the start mode to Automatic and click OK.

vi. Right-click the SQL Server Browser again, and select Start.

b. In the SQL Server drop-down list, select the desired server. If instead you enter a server
manually, click Connect.
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NOTE: You can alternatively enter the IP Address or Computer Name of the
server in the SQL Server field. Use this format: <Server
Name>\<SQL Instance> or <IP Address>\<SQL Instance>
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IF YOU ENCOUNTER A CONNECTION FAILURE

If the SQL Server is not local (i.e., it resides of a different server than the Pulse web
server), it is common for users who might be less familiar with networking to experience
failures when the following is true:

n The SQL Server name and/or instance was entered incorrectly. You must enter the
correct server name and instance.

n The account that you are using to perform the installation does not have sysadmin
permission on the SQL Server. See your SQL Server Administrator or Network
Administrator for the appropriate account to use.
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n The SQL Server resides in an untrusted Windows domain. There must be a domain
trust relationship between the Pulse web server and SQL server hosting the Pulse
database. Make sure you selected the correct server.

c. If necessary, complete the authentication fields at the bottom of the page.

d. Click Next.

6. In the Database Options page, select one of the following options:

n Create new This creates a new database instance with Pulse.

OR

n Use existing Select this option only if you have previously installed Pulse. You may click
the Browse (…) button to open the Select Database dialog. Select the desired Pulse Data-
base ID from the list. Then click Connect. Then click OK.

7. If necessary, in the Backup path for local SQL database field, you can click the browse button
and choose a location to store a copy of the current database. This field is only enabled if the
database has been using a previous version of Pulse. Also, it is not enabled if you are con-
necting to a database on a remote server.
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8. In the PulseAdmin Password box, specify the password for the default Pulse Administrator
account. Then click Next.

IMPORTANT: Record this password in a safe place. This is the default PulseAdmin
account. You will need this information to log into the Pulse dashboard for the first
time.
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NOTE: As you type, the program lets you know when your password meets the min-
imum password strength thresholds, such as Very Weak, Medium, Strong, Very
Strong, and Excellent.

9. In the Configure SMTP page, enter your SMTP server settings:

NOTE: To get your SMTP server settings, see your Email or Network Administrator.

n SMTP Server This is the IP address of the SMTP relay that accepts incoming requests
which is the host that will send outbound emails for Pulse.

n SMTP Port This is the port number of the SMTP server handing outbound emails. This is
Port 25 (or the port number for your environment).

n SMTP User Name This is the username of a valid account on the SMTP relay.

n SMTP Password This is the password for the valid account on the SMTP relay.

n From Address This is the from address for emails sent by Pulse. You must have a valid
address for this account. For example, type: PulseRegistration@example.com.

n From Display Name This is the name that displays in email client applications for the
email address. For example, type: Pulse Registration.

n Enable SSL A check mark in this box enables Secure Socket Layers (SSL) encryption. It is
recommended that you leave this box blank.
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NOTE:  If you have content security requirements, purchasing an SSL certificate
for your web domain is suggested. This lets you enable SSL transport security, so
users can access your site via the https:// protocol. This ensures that the page
content that a URL points to is encrypted while the data is being transmitted to
your end user (so the content is not visible to others as it passes through the com-
munication chain). See your Network Administrator for more information about
SSL.
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10. (Optional) Test your SMTP settings.

a. In the Configure SMTP dialog, click Test.

b. In the SMTP Test dialog, enter a valid address in the Email address box.

c. Click Send Test Email.

d. Depending on which message you see, do the following:

n Test message has been sent Click OK. Then check the email account to ensure
you received the test email.

n Error sending message Click OK. Ensure that you entered the correct
SMTP settings for your environment. Then try testing the settings again.

11. Click Next. The Verify Configuration page appears.

12. In the Verify Configuration page, review the components list. When you are ready to proceed,
click Next. A progress indicator shows you the status of the installation.

13. When the Configuration Complete page appears, you can click View Log or Save Log if you
want to see or save the results.

14. Click Finish.
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Starting the Pulse Server Application
When you start the Pulse server application, the system opens the Pulse Server Configuration win-
dow.

HOW TO START THE PULSE SERVER APPLICATION

1. Log in to the Pulse web server as an administrator.

2. Start the Pulse application by selecting one of these options:

n Desktop Shortcut On the Windows desktop, click the MadCap Pulse shortcut. This is auto-
matically added to the desktop at the end of the installation process.

n Start Menu In Windows, click Start > All Programs > MadCap Software > MadCap Pulse.

n Program Files Double-click the program icon in the Program Files directory. If you
installed the program using the default installation folder, it is located at one of these
paths:

l On 64-bit Platforms C:\Program Files\MadCap Software\MadCap Pulse\Pulse.ap-
p\Pulse.app

l On 32-bit Platforms C:\Program Files (x86)\MadCap Software\MadCap
Pulse\Pulse.app\Pulse.app

Here is the Pulse Server Configuration window:
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Setting the PulseAdmin Password
During the Pulse installation, you created a password for the default PulseAdmin account. You can
reset that password at any time.

HOW TO SET THE PULSEADMIN PASSWORD

1. Log in to the Pulse web server as an administrator:

n Username The username is always "PulseAdmin" by default.

n Password This is the password that you defined during when you installed the Pulse
server application.

2. Start the Pulse server application.

3. Select File > Set Admin Password.

4. In the Set PulseAdmin Password box, type a new password. Then click OK.

5. In the configuration dialog, click OK to acknowledge that your password was updated.
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Pulse Server Configuration Window
The Pulse Server Configuration window contains options that let you perform a variety of main-
tenance and management tasks.

GENERAL TAB

The controls in the General tab give you the ability to view and test the general connection settings
for the Pulse server application.
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User Inter-
face

Description

SQL Server Contains information about your Pulse database.

Server
Name

A read-only field that shows the computer name of the SQL Server and the
instance for the Pulse database.

Databases A read-only field that shows the Database IDs for the Pulse databases.

Test Click this button to test the database connection settings.

HOW TO TEST THE SQL SERVER SETTINGS

1. Launch the Pulse server application.

2. In the Pulse Server Configuration window, select the General tab.

3. In the SQL Server area, review the Server Name and Databases that were
configured during installation.

4. Click Test.

5. If the test is successful, the system shows a message indicating this.

6. Click OK to close the message.

Web Site Contains information about the site running on your Pulse web server.

Location Typically this reads Default Web Site.

URL The URL for the Pulse dashboard.
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User Inter-
face

Description

View Click this button to open the Pulse dashboard in a web browser.

HOW TO VIEW THE WEB SITE SETTINGS

1. Start the Pulse server application.

2. In the Pulse Server Configuration window, select the General tab.

3. Click View.

4. Depending on your configuration, one of the following occurs:

n If You are Able to View the Web Site If your web site settings is properly
configured, the Pulse dashboard appears in a separate browser window.

OR

n If You are Not Able to View the Web Site If your web site settings are not
properly configured, a "Pulse was not able to process your request
message" may appear.See "Frequently Asked Questions" on page 123.

Test Click this button to test the web site settings.

HOW TO TEST THE WEB SITE SETTINGS

1. Start the Pulse server application.

2. In the Pulse Server Configuration window, select the General tab.

3. Click Test.

4. Depending on your configuration, one of the following occurs:

n Web site test succeeded If your web site settings is properly configured,
the Web site test succeeded dialog appears.

OR

n Web site test failed If your test is not successful, an error message is
shown.See "Frequently Asked Questions" on page 123.
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USERS TAB

The controls in the Users tab provides you with user counts and name information.
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User Inter-
face

Description

Groups Select one of the listed groups from the drop-down list.

HOW TO VIEW USER COUNTS AND INFORMATION

1. Start the Pulse server application.

2. In the Pulse Server Configuration window, select the Users tab.

3. From the Groups list, select one of these options:

n All View counts and users for all administrative and registered users.

n Administrators View user counts and member information for the Admin-
istrators group.

n Customers View user counts and member information for members of
the Customers group

n Employees View user counts and member information for members of
the Employees group

Count A read-only field. Shows the total number of users for the selected group.

First Name A read-only field. The last name of the user.

Last Name A read-only field. The first name of the user.

Email
Address

A read-only field. A valid email address for the user.
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MAINTENANCE TAB

The controls in the Maintenance tab lets you manage the Pulseserver application's services. The
options that are available in this dialog depend on the version of Microsoft SQL Server being used:

n If You are Using Microsoft SQL Server Express Edition with Advanced Services You have the
ability to view and start the Pulse Server and RabbitMQ service (these are both services that
run in Windows). You also have the ability to schedule database backups.

HOW TO SCHEDULE A BACKUP

This feature is available only when the Pulse database is using Microsoft SQL Server
Express Edition with Advanced Services.

Use the Maintenance tab to schedule backups of your Pulse database, whether it resides on
the local server or a different server on the network.

You can schedule a backup of your Pulse database on the SQL server on a daily or weekly
schedule. This saves your database information in a backup file (e.g., a file with the BAK file
name extension).

In the event that a database recovery is needed, your SQL Administrator can use SQL Server
Management Studio to restore your Pulse database using the latest backup file.
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IMPORTANT: For a backup to take place at the scheduled time, the Pulse web
server must be powered on and the MadCap Pulse Management Service and Rab-
bitMQ service and must be running.

1. Start the Pulse server application.

2. In the Pulse Server Configuration window, select the Maintenance tab.

3. In the Location field, click Browse. Then, navigate to the directory where you want to
save the backup files. Important things to keep in mind:

l Local Backup If you want to store the backup file (BAK) on the local system, the
default backup folder is : C:\Databases. This is the recommended method.

l Network Drive If you want to store the backup file (BAK) on a network drive, select
the desired location.

NOTE: If you choose this method, the Pulse web server must have per-
mission to write to the drive. In addition, the system drive must be
powered on and connected to the network at the scheduled backup time.

4. In the Day & Time fields, specify the desired backup schedule:

l Daily or Weekly Select either Daily or Weekly.

l Day of Week If you select a Weekly backup schedule, you can also select the
desired day to perform the backup.

l Time Select the time of day to perform the backup.
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5. As long as the listed Services are running, you will not need to click Start. In the event
that services stop running,simply click Start to restart the services and backup sched-
ule.

WARNING: You do not have the ability to disable the MadCap Pulse Man-
agement Service or Rabbit MQ service. To function properly, the Pulse server
application requires these Services to run in the background.

6. Save your changes by selecting File > Save.

NOTE: If you do not save your changes, you will be prompted to save them
when you exit the application.

n If You are Using a Different Edition of Microsoft SQL Server You have the ability to view the
status of and start the Pulse Service and RabbitMQ service. However, backups are not sup-
ported by Pulse. This is because the full versions of SQL provide administrators with several
options for creating full database backups.
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HOW TO BACKUP AND RESTORE DATABASES IN SQL SERVER

To learn how to backup and restore a database in SQL server, see the Microsoft SQL Server
web site at:

l For SQL Server 2012 http://technet.microsoft.com/en-us/library/ms187048
(v=sql.110).aspx

l For SQL Server 2008 R2 http://technet.microsoft.com/en-us/library/ms187048
(v=sql.105).aspx

l For SQL Server 2008 http://technet.microsoft.com/en-us/library/ms187048
(v=sql.100).aspx
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Importing Feedback Data
If your company previously used the MadCap Feedback product, you can import information from
your existing Feedback database into the Pulse database.

WHAT GETS IMPORTED

The following describes what Feedback data is imported to the Pulse database:

n Report Data All of the report data.

n Comments All of the comments.

n User Information All of the user account information, except passwords.

IMPORTANT: Feedback users do not have passwords. Their email address will serve as
both their user name and password (e.g., if you have a user with bob@example.com, his
password will now be bob@example.com). Users can change this password by clicking the
Forgot your password? link in any Pulse Account Login page.

HOW TO IMPORT FEEDBACK DATA

1. Launch the Pulse server application.

2. Click Import Feedback Data.

3. In the Select SQL Server and Database dialog, complete the following:

n SQL Server The computer name of the SQL server.

n Authentication The authentication method.

n User name The account username.

n Password The account password.

n Database The SQL Server instance.

4. Click OK.
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Updating Pulse
You may periodically wish to check to see if there are updates for the Pulse server application to
download.

HOW TO UPDATE PULSE

1. Launch the Pulse server application.

2. In the toolbar, select Help > Check for Updates.

3. In the dialog that opens:

n No Updates Available If not updates are available, simply click Close.

n Updates Available If updates are available, highlight the update in the Download list. Then
click Download Updates.
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Uninstalling Pulse
You can uninstall the Pulse server and the application.

HOW TO UNINSTALL THE PULSE SERVER

When you use this method to remove Pulse, only the configuration information for the Pulse server
is removed. The existing Pulse database remains untouched by this process. It also leaves the Pulse
server application on the system, so you can reconfigure it at a later time.

When prompted to decide if you want to proceed, click Yes. The system removes all of the Pulse
server's configuration information.

1. Log in to the Pulse web server as an administrator.

2. Launch the Pulse server application.

3. In the toolbar, click the Uninstall Pulse Server button.

4. When prompted to decide if you want to proceed, click Yes. The system removes all of the
Pulse server's configuration information.

The next time you launch Pulse, you will need to activate and configure the server for first-time use.
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HOW TO UNINSTALL THE PULSE SERVER APPLICATION

If you want to completely remove the Pulse application from the server, use the Windows Control
panel.

1. Log in to the Pulse web server as an administrator.

2. Open the Windows Control Panel.

3. Under Programs, click Uninstall a Program.

4. In the Uninstall or Change a Program page, right-click MadCap Pulse and select Uninstall from
the context menu.

5. In the Programs and Features dialog, click Yes..

6. In the MadCap Pulse dialog, a list of applications related to Pulse appears. Review the list and
select Automatically close applications and attempt to restart them after setup is complete.
Then click OK. Windows begins removing the Pulse server application.
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CHAPTER 7

Integrating Flare and Pulse
To integrate the embedded discussion forms and other Pulse features with your Flare output, add a
new community in Flare. This action automatically creates a new system in Pulse, allowing your
web server to host, store, and serve the embedded discussion forms that appear below the topics in
your Flare output. This system also gives you and your team members the ability to moderate and
administer the Pulse features and content from the Pulse dashboard.

This chapter discusses the following:

Integration Options 90

Enabling the Pulse Server 91

Setting Up the Community in Flare 94

Mapping/Remapping a Flare Community to Pulse 103

Enabling the Community Tab in the Output 115

Setting the Community Options—Comments and Search Results 118

Building and Publishing the Flare Output 122
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Integration Options
If you are developing an online Flare target for a single product, service, or purpose, integrating Flare
is a straightforward process. You simply install Pulse and then add a new Flare community to create
a corresponding system in Pulse. However, because many organizations develop multiple Flare tar-
gets, you also have these options:

n Add a Single Flare Community for Use With Multiple Targets In this scenario, you add one
Flare community which creates a corresponding Pulse system. Then you associate that com-
munity with multiple Flare targets. This method gives you less-granular reporting capabilities
in Pulse.

n Add a Unique Flare Community for Each Different Target In this scenario, you add a unique
Flare community for each different target. This creates a separate system in Pulse. The
advantage of using this option is that it gives you more granular reporting capabilities, letting
you generate usage reports for each community.
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Enabling the Pulse Server
To give Flare the ability to interact with Pulse, you must supply the Flare community in the target
with the appropriate connection information and administrative access credentials for the Pulse
web server.

HOW TO ENABLE THE PULSE SERVER

1. Open the desired Flare project.

2. In the Project Organizer, open the desired WebHelp or HTML5 target.

3. In the Target Editor, select the Community tab.

4. Enable the server as follows:

a. At the top of the Community tab, place a check mark in the Enable Pulse/Feedback
Server box.

b. In the URL field, type the URL for the Pulse web server.
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NOTE: To find the URL, log in to the Pulse dashboard as an administrator. Then
select Administration > Settings > General Settings. The URL above corresponds
to the value in the Site URL box.

NOTE: If you have installed a Secure Sockets Layer (SSL) certificate on the
Pulse web server, ensure that the URL starts with the https:// protocol (instead
of http://).

c. Enter the access credentials as appropriate:

n If this is the first time you are enabling the Pulse community in the Flare target, the
Log In dialog automatically appears.

OR

n If you want to change the existing login information, click the Logout button to clear
the existing credentials. Then click Login. The Log In dialog appears.

d. In the Log In dialog, type the appropriate User name and Password. The account that you
use must have administrative permissions to Pulse. You have these options:

n Use the PulseAdmin Account This is the default administrator account that was cre-
ated by the person who installed Pulse.
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n Use an Account that is a Member of the Administrators Group This can be any
account belonging to a registered Pulse user who is a member of the Administrators
group.

e. Click OK or press Enter to close the Log In dialog.

f. Before you can save the Flare target, you must associate a Flare community with the
Pulse system.
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Setting Up the Community in Flare
After enabling the Pulse server in the desired target, you can set up the community in Flare. If you
are setting up Flare for the first time, you will add a new Flare community.

HOW TO ADD A NEW FLARE COMMUNITY

If this is the first time you are integrating Flare andPulse, add a new Flare community to your pro-
ject's Flare target. This process automatically creates a new "system" on the Pulse server. In Pulse,
a system hosts the following items:

n The activity streams that are used when moderating your topics with the Pulse dashboard

n The embedded discussion forms that registered Pulse users can access in the Flare output

IMPORTANT: To integrate Flare content with Pulse integration, you must always add new
or use existing communities in Flare. While you have the ability to create systems using the
Pulse dashboard, you do not have the ability integrate those systems with a Flare com-
munity.

1. In the Community tab, locate the Communities list and then click Manage.
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2. In the Manage Community dialog, click Add.

3. In the Enter Name dialog, type a name for your community. In this example, we are creating a
community to use with a Flare target about Pets. Then click OK.

4. In the Manage Communities dialog, the new community appears. Click OK to close the dialog.

5. Click Refresh to update the Current Pulse Configuration info. This provides you with basic
information about the community, such as the status of the server, and the total number of
users.

After the community is associated with the Flare target, the Remap Topics button becomes avail-
able so you can map your community topics to Pulse for the first time.
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You also have the ability to select an existing community, delete a community, provide a published
URL, and rename a community as follows:

HOW TO SELECT AN EXISTING FLARE COMMUNITY

If you need to publish any updates for your Flare output and do not wish to create a new community
for your documentation release, select the community that you previously created for the target.
This gives you the ability to ensure that any new, removed, and updated topics are mapped to the
appropriate embedded discussion forms in the Pulse system.

1. In the Community tab, locate the Community area.

2. From the Communities list, select an existing community.

3. Click Refresh to update the Current Pulse Configuration info. This provides you with basic
information about the community, such as the status of the server, and the total number of
users.

NOTE: The Communities list in Flare initially only includes communities that have
been added with the Flare user interface. If you create Pulse systems using the Pulse
dashboard, those systems will be not be listed as Flare communities until you remap
the topics.

NOTE: You can associate multiple Flare targets with a single community if desired.
However, for best results with reporting, we recommend that you create a separate
community for each target. This will also simplify any mapping/remapping tasks
when you publish updates.
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NOTE: If you want to verify that the Flare community you added is now a system in
Pulse, log in to the Pulse dashboard using an account that is a member of the Admin-
istrators or Employees group. The select Systems > Find Systems from the menu.
The community you created will appear in the list.

After the community is activated, the Remap Topics button becomes available so you can
remap the community topics to Pulse.
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HOW TO DELETE A FLARE COMMUNITY

If you want to delete a Flare community, use the steps below. This deletes both the Flare com-
munity and the Pulse system.

1. In the Community tab, locate the Communities list and click the Manage.

2. In the Manage Community dialog, select the community that you want to remove. Then click
Delete.

3. When prompted to confirm the delete action, click Yes. This removes your selection from the
Communities list.

4. Click OK to close the Manage Communities dialog.

5. Click Remap Topics and confirm the topics to remove.

6. Click to save your work.
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HOW TO PROVIDE A PUBLISHED URL FOR A COMMUNITY

You can assign a URL path to your community from your Flare target (if you have Flare 10.2 or later
installed). This can also be done from the Pulse dashboard (by selecting Administration > Settings
and clicking Communities), but using the Flare target is recommended.

1. Under the Community area, click the Manage button.

2. In the Manage Communities dialog, highlight the community that you want to edit. Then click
Edit

3. In the Edit Community dialog, click in the Enter published url field and enter a path to the main
landing page of your Flare output.

When you enter a published URL path, make sure you include http:// at the beginning of the
URL.
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EXAMPLE

Let's say you've generated a target called "FlareOutput" and you've uploaded the
output so that users access it
here: help.mycompany.com/FlareOutput/Default.htm. In that case, enter
http://help.mycompany.com/FlareOutput in the Published Url field.

4. Click OK to close the Edit Community dialog. Click OK to close the Edit Community dialog.

5. Click OK to close the Manage Communities dialog.

6. Click to save your work.

Why is it a good idea to assign a URL path to a community? Because it allows topic feeds to open in
context.

EXAMPLE

Let's say you have not provided a published URL for your community. You receive an
email notification stating that a user has posted a comment in one of your topics. So
you click the topic name link in the email notification to see the feed where the com-
ment was posted. The feed opens in the dashboard view of Pulse, which shows only
the feed and not the topic associated with it.
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On the other hand, let's say you provide a published URL to your community. In that
case, when you click the topic link, the topic opens in the actual Flare output. You see
both the topic and the Pulse feed below it, therefore giving context to the post.
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HOW TO RENAME A FLARE COMMUNITY

1. In the Community tab, under Current Pulse Configuration, click the Refresh button.

2. Under the Community area, click the Remap Topics button ensure your topics have been
mapped

3. Under the Community area, click the Manage button.

4. In the Manage Community dialog, highlight the community that you want to rename. Then
click Rename.

In order to add the embedded discussion forms to the Flare output that you will publish, you
must map/remap the community topics in Flare for Pulse.

5. In the Enter Name dialog, type a new name for your community. Then click OK.

This changes the name of the community in Flare, as well as the name of its corresponding
Pulse system.

NOTE: If an error message appears, try clicking the Refresh button and the remap-
ping the topics. This typically resolves any issues.

6. Click OK to close the Manage Communities dialog.

7. Click to save your work.
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Mapping/Remapping a Flare Community to
Pulse
In order to add the embedded discussion forms to the Flare output that you will publish, you must
map/remap the community topics in Flare for Pulse.

HOW TO MAP A NEW FLARE COMMUNITY TO A PULSE SYSTEM

If this is the first time you are setting up a Flare community for a target, you will need to map the top-
ics for your community to Pulse.

1. Make the desired changes to your Flare target. Always be sure to update the TOC before
remapping the topics.

2. In the Target Editor, select the Community tab.

3. From the Communities drop-down list, select the appropriate community.

4. Click Remap Topics.
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This opens the Remap Community Topics dialog.
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5. In the Remap Community Topics dialog, make sure the New Topics tab is selected and review
the topics in the list.

EXAMPLE

A topic count appears in the label of the New Topics tab. The tab lists the topic
titles and paths to the topics. These items will be mapped to a corresponding
stream in Pulse. In a new community, the counts in the other tabs will typically be
zero (0).

6. When finished, click OK. The system automatically maps each community to a stream in
Pulse. The community updated message appears.

7. Click to save your work.
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HOW TO REMAP A FLARE COMMUNITY TO AN EXISTING PULSE SYSTEM

As you prepare to publish content updates to a Flare target, you can review the new, removed, and
updated topics and then reassign any of the topics to the appropriate stream in the Pulse system.
This stream corresponds to the embedded discussion form at the bottom of the Flare topic.

1. Make your content changes in Flare. Be sure to make all of the desired updates in the Flare
TOC associated with your target.

2. Open the Flare target.

3. In the Target Editor, select the Community tab.

4. From the Communities drop-down list, select the appropriate community.

5. Click Remap Topics. This opens the Remap Community Topics dialog so you can review the
updates:

NEW TOPICS TAB

The New Topics tab lists Flare updates that have an effect on the Pulse mapping definitions:

n New Topics New topics that have been added to the Flare TOC associated with the tar-
get.

n Moved Topics Existing topics that have been moved to a different folder or location in
the Content Explorer.

n Renamed Topics (New Name) Existing topics where the actual file name has changed.
The new file name appears in this tab.
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REMOVE TOPICS TAB

The Remove Topics tab lists Flare updates that have an effect on the Pulse mapping defin-
itions:

n Deleted Topics Topics that have been removed from the Flare TOC associated with the
target.

n Moved Topics Existing topics that have been moved to a different folder or location in
the Content Explorer.

n Renamed Topics (Former Name) Existing topics where the file name has changed. The
former file name appears in this tab.

UPDATE TOPICS TAB

The Update Topics tab only lists community topic updates that specifically relate to Pulse
mapping definitions. This includes topic updates such as title changes, reassigned links, and
so on.

CHAPTER 7  107



EXCLUDE TOPICS TAB

The Exclude Topics tab lists all topic files where Flare changes have no effect on the Pulse
mapping definitions.

When finished, click OK. The community updated message appears.

6. Review the topics in each tab and then reassign the links as desired. See below for instruc-
tions.

7. When finished, click OK. The community updated message appears.
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HOW TO REASSIGN A LINK

When you are preparing to publish content updates for a Flare target, there may occasionally be
times when you want to reassign a link that is associated with a community topic. This lets you take
the embedded discussion form associated with a topic and associate it with a different topic.

EXAMPLE

Let's say you have a topic with the file name, "Feeding_Cats.htm" and you decide to
rename it, "Feeding_a_Cat.htm." When you make this change, the Remap Community
Topics dialog will list this change in two places.

The New Topics tab will shown the new topic file name. If you click OK in the dialog,
the system would add a new stream for the topic in the Pulse system:

The Remove Topics tab will show the former file name. If you click OK in the dialog,
the system would remove the corresponding stream for the topic in the Pulse system:
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Instead of creating a new stream for the new topic named "Feeding_a_Cat.htm", let's
say you want to keep the discussion from the existing stream associated with "Feed-
ing_Cats.htm." You can reassign the link to tie the discussion with the old file name to
the new file name.
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HOW TO REASSIGN A LINK

1. Make your content changes in Flare. Be sure to make all of the desired updates in the Flare
TOC associated with your target.

2. Open the Flare target.

3. In the Target Editor, select the Community tab.

4. Select the appropriate Flare community in the Community drop-down list.

5. Click Remap Topics. This opens the Remap Community Topics dialog so you can review the
updates. In this example, we've renamed a topic file from "Feeding_Cats.htm" to "Feeding_a_
Cat.htm."

6. In the New Topic tab, right-click the new topic and select Reassign Link from the context
menu.

This opens the Reassign Community Link dialog.
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7. From the Select Links drop-down list, select the desired topic. This will map the embedded
discussion form for the selected link with the topic. In this example, we will select the topic
formerly named, "Feeding_Cats.htm."

8. When finished, click OK. The community updated message appears.

When you republish your Flare target, the discussion originally linked to the former file is now
linked to the new file.
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HOW TO VERIFY THE COMMUNITY TOPICS IN THE PULSE SYSTEM

To see the community topics that have been created for your Flare output:

1. Log in to the Pulse dashboard with an appropriate user account.

NOTE: To access systems, you must be a member of the Administrators or Employ-
ees group.

2. In the menu bar, select Systems > Find Systems. The Find Systems page appears.

3. Under New Systems, click the Pulse system that corresponds to the appropriate Flare com-
munity.

4. In the community page, click the Topics link.
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5. In the list of topics, click a topic. Any community activity for the topic will be reflected in the
stream.
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Enabling the Community Tab in the Output
You need to decide whether you want to include or exclude the Community tab with your published
output. For HTML5 output, this can be done for Tripane skins only.

Below is an example of the Community tab:

You can enable or disable this feature by editing the general features of the skin associated with the
Flare target.
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The benefits of including the Community tab in your output include:

n Gives site visitors the ability to register for a Pulse account. Also gives registered users the
ability to log in to Pulse directly from the Flare output.
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n Gives registered users the ability to edit their profile, which includes changing their avatar
image, updating personal information, and modifying notification preferences.

NOTE: You cannot add a Community pane to Top Navigation or skinless HTML5 output,
because those outputs do not use panes. However, registered users can open the dash-
board in a browser and access some of the features that are normally available in the Com-
munity pane in the Flare output (depending on the access level).
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Setting the Community Options—Comments
and Search Results
You can set community options, which control the display of comments and search results. For
both Standard and HTML5 skins, you can do this in the Skin Editor. For HTML5 outputs—including
skinless—you can also use your stylesheet to display or hide topic comments; this makes it possible
to show comments for some topics but hide them for others.

HOW TO SET THE COMMUNITY OPTIONS USING A SKIN

1. In the Project Organizer, open a Standard or HTML5 skin.

2. In the Skin Editor, click the Community tab. You have these options:

TO DISPLAY TOPIC COMMENTS

If you want registered Pulse users to have the ability to post comments in the embedded dis-
cussion forms that Pulse includes at the bottom of the Flare topics, place a check mark in the
Display topic comments at the end of each topic check box. This check box is selected by
default.

TO DISPLAY COMMUNITY SEARCH RESULTS

You can configure the Flare skin to give the Flare search engine the ability to index the Pulse
system and return any community results when end users perform searches.
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EXAMPLES

In HTML5 output, Pulse posts matching the search query are listed on the
Search Results page under a Community Results link:
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If a user clicks the Community Results link shown above, only the matching
Pulse content appears in the results page:

Users can then hover the mouse cursor over the content to reveal a links that
open either the matching Pulsepost, the matching Flare topic and the match-
ingPulse post, or the Pulse user feed.

This feature works similarly in WebHelp output.

TO DISPLAY SEARCH RESULTS

a. Open a Standard or HTML5 skin.

b. Click the Community tab.

c. Place a check mark in the Display community search results box.

d. (Optional) In the Number of community search results field, you can enter the number
of community search results shown by default when a search is made in the output.
The default number in this field is 3.
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NOTE: The Feedback area in the Community tab of the Skin Editor is only relevant to
Feedback Server Admin. The Feedback option is not supported by Pulse.

3. Click to save your work.
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Building and Publishing the Flare Output
Once you set up the community features, you can build and publish your Flare output.

When building the output, you may see a message that states, "Some community features will not
be displayed in tablet and mobile outputs." This means that when users are viewing your responsive
output on a tablet or phone, they will not see comments or the Community tab. However, Pulse still
tracks hits on pages in those formats for reporting purposes. You can hide the warning if you do not
want to see it in future builds.
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CHAPTER 8

Frequently Asked Questions
Following are some frequent questions about the Pulse installation and administration tasks.

This chapter discusses the following:

General 124

Windows Installer 125

.NET Framework 126

IIS 130

Pulse Setup Program 139

Pulse Server Application 140

RabbitMQ 144

User Administration 146
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General
Following are general frequently asked questions about the Pulse installation.

DO I HAVE TO HOST MY FLARE CONTENT ON THE PULSE WEB SERVER?

No. You can host the published Flare output on any server, computer, or location that has access to
your Pulse web server.

DO I NEED A SEPARATE LICENSE CODE FOR EACH FLARE TARGET THAT I PUBLISH?

No. Each Flare target can be set up to have its own Pulse community. With Pulse, you can create an
unlimited number of communities using the same license code.

HOW DO I INTEGRATE PULSE WITH MY FLARE CONTENT?

If you have installed Pulse, you can now open the Flare project and enable the Pulse features using
the Community Tab in the Flare target. See "Integrating Flare and Pulse" on page 89.
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Windows Installer
Following are frequently asked questions about the Windows installer.

WHAT VERSION OF WINDOWS INSTALLER DO I HAVE?

1. In the Windows Start menu, type Run in the Search Programs and Files box. Select Run from
the Program menu to open the Run dialog.

2. In the Open box, type system32. Then, press Enter or click OK.

3. Locate the file named "msiexec.exe."

4. Right-click the file and select Properties from the context menu.

5. Click the Details tab.

6. In the field next to Product Version, ensure that your system is running Version 4.5 or higher.
You should be running version 4.5.6001.22159 or greater. Most systems will be running ver-
sion 5.0, which meets the minimum requirement.
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.NET Framework
Following are frequently asked questions about the .NET framework.

HOW DO I DETERMINE IF THE .NET FRAMEWORK IS ALREADY INSTALLED?

1. In the Windows Start menu, type Run in the Search Programs and Files box. Then select Run
from the Program menu to open the Run dialog.

2. In the Open box, type regedit.exe. Then, press Enter or click OK.

3. If you are prompted by the following User Account Control message. Click Yes to open the
Registry Editor.

4. In the Registry Editor, the following registry keys will be visible if the required versions are
installed:

IMPORTANT: When checking the information below, always make sure you are veri-
fying the version numbers in the in "NET Framework Setup" directory and not the
".NET Framework" directory.
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n For Version 4.0 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Frame-
work Setup\NDP\v4\Full. You should see 4.0 or above in the Version row.

n For Version 4.5 Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\NET Frame-
work Setup\NDP\v4\Full. The existence of DWORD in the Release row indicates that
.NET 4.5 or above is installed. The number shown in parentheses refers to a specific .NET
version (see http://msdn.microsoft.com/en-us/library/hh925568(v=vs.110).aspx).
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SHOULD I INSTALL THE FULL PACKAGE OR CLIENT PACKAGE?

You should always install the full package when working with server applications. The full frame-
work provides a number of features and assemblies that are not available with the client package.
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IIS
Following are frequently asked questions about IIS.

WHAT IS IIS?

Internet Information Services is a web service role that is enabled in the operating system to give
the system its web server capabilities. IIS must be installed on the computer that will be acting as
your Pulse web server.

HOW DO I DETERMINE IF IIS IS INSTALLED?

There are two ways to determine if IIS is installed on a system:

INSTRUCTIONS FOR USING THE WINDOWS CONTROL PANEL

1. Open the Windows Control Panel.

2. Click Programs.Then under Programs and Features click Turn Windows features on or off.

The Windows Features On or Off dialog appears.

3. Look for Internet Information Services.

INSTRUCTIONS FOR USING RUN COMMAND

1. Open the Start menu and choose Run.

2. In the Run dialog, type inetmgr Then, press Enter or click OK.

3. If the Internet Information Services (IIS) Manager appears, the program is installed.
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IIS IS ALREADY INSTALLED ON OUR SERVER. HOW DO I CREATE A NEW WEB SITE FOR
PULSE IN IIS?

When you install IIS for the first time, a "Default Web Site" is automatically created in the \inet-
pub\wwwroot directory on the web server. You can either use this default directory to publish the
Pulse content or you can create a new directory in the IIS file system by following these steps:

1. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager.

CHAPTER 8  131



2. In the Connections pane, right-click the Sites container and select Add Web Site.

3. In the Add Web Site dialog, type a name for your Pulse site in the Site name box. For example,
type Pulse

4. In the Application pool box, make sure the desired application pool appears. In this example,
the default application pool is named Pulse.
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NOTE: If you want to use a different application pool, click the Select button. Then,
choose the desired Application pool from the list and click OK.

5. In the Physical path box, type the physical path to the folder that you want to use as your con-
tent directory for Pulse. In this example, we created this folder structure: %Sys-
temDrive%\pulsepub\wwwroot.

6. From the Type list, select the desired protocol. In this example, we selected http.

7. In the IP address box, type a static IP address.

8. Type a port number in the Port text box. The default port number is 80.

9. If you want to use a host name for your URL, enter it in the Host name box. In this example, we
are using pulse.example.com.

10. If you do not have to make any changes to the site, and you want the web site to be imme-
diately available, place a check mark in the Start Web site immediately box.

11. Click OK.
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HOW DO I USE A HOST NAME FOR THE PULSE URL?

By default, the Default Web Site that Pulse uses to serve your dashboard content requires you type
<localhost>/Pulse to gain access your dashboard content. However, you can change the localhost
to a domain name, if desired.

EXAMPLE

Let's say that to access your Pulse dashboard content users must type:
http://127.0.0.1/Pulse/ in the browser address bar. Using the steps below, you
can change the host name to give users the ability to type: http://pulse.ex-
ample.com.

1. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager.
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2. Right-click your Pulse web site and select Switch to Features View from the menu.

NOTE: In this example, we are using the Default Web Site for Pulse.
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3. In Features View, under the ASP.NET area, right-click Providers and select Bindings from the
context menu.
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4. In the Site Bindings dialog, highlight the appropriate protocol. In this example, we highlighted
the protocol http in the Type column.Then click Edit.

5. In the Edit Site Binding box, type the host name for your Pulse URL. For example,
type: pulse.example.com. Then click OK.
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6. In the Site Bindings dialog, click Close.

7. Select File > Exit to close IIS Manager.
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Pulse Setup Program
Following are frequently asked questions about the Pulse setup program.

DO I INSTALL THE .NET FRAMEWORK BEFORE PULSE?

Yes. The .NET Framework is a prerequisite for the Pulse setup program. If you do not install the
framework, a notification message similar to the following one will appear when you attempt to run
the Pulse setup program on the server:

You should click Yes in the error message. This will direct you to the Microsoft .NET Framework
(Web Installer) page in a new browser window, so you can download and install the framework.
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Pulse Server Application
Following are frequently asked questions about the Pulse server application.

WHY AM I SEEING THE "PULSE WAS UNABLE TO PROCESS YOUR REQUEST"
MESSAGE?

This message displays when you are attempting to log in to the Pulse dashboard.
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When this message appears, first try refreshing your browser content. If the message still appears,
it typically means that IIS is not able to properly handle responses for the ExtensionlessURL
resources. This can quickly be resolved in Internet Information Services (IIS) Manager.

1. Log in to the Pulse web server as an administrator.

2. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager..

3. In the left pane, double-click the appropriate connection. Then double click Handler
Mappings.
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4. In the Actions pane, click View Ordered List

5. Look for these mappings in the Name column:ExtensionlessUrl-ISAPI-4.0_32bitEx-
tensionlessUrl-ISAPI-4.0_32bitExtensionlessURL-Integrated-4.0

6. Select each mapping individually. Then in the Actions pane, click Move Down until all of the
mappings are near the bottom of the list, just above StaticFile.

7. Close the IIS Manager.
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WHY AM I SEEING THE "WEB SITE TEST FAILED" MESSAGE?

If you encounter the "Web site test failed" message when testing your web site setting in the Pulse
Server Configuration window, it is recommended that you first ensure your Pulse web site is running
in IIS.

1. Log in to the Pulse web server as an administrator.

2. Click Start > Administrative Tools and select the Internet Information Services (IIS) Manager..

3. In the Connections pane on the left side of the window, expand the Sites container.

4. Locate your Pulse web site. In this example, the Pulse web site is the "Default Web Site."

5. Right-click the website and select Manage Web Site > Start from the context menu.

If your website is running successfully, we recommend returning to the Pulse Server Configuration
window in the Pulse server application. Then, test your website settings again.
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RabbitMQ
Following are frequently asked questions about RabbitMQ.

WHAT IS RABBITMQ?

The Pulse setup program installs a third-party tool, RabbitMQ. This runs as a Windows service and
supports communication between the Pulse web server (IIS) and the SQL Server hosting your Pulse
database.

RabbitMQ monitors the amount of RAM on the server, to raise alarms and block connections until
the alarm is cleared. This is helpful because it will assist you preventing the server from crashing
should free disk space get low.

WHERE IS THE RABBITMQ SERVICE INSTALLED?

The Pulse setup program installs the RabbitMQ tool at this path where Pulse is installed: C:\Program
Files (x86)\MadCap Software\MadCap Pulse\Pulse.app\Tools. Please note that this is just an
example. Your files might be in different folder than C:\Program Files (x86).
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Once installed, Pulse runs the RabbitMQ tool as a Windows service:
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User Administration
Following are frequently asked questions about user administration.

HOW DO I REMOVE A USER SO THEY CAN RE-USE THEIR EMAIL ADDRESS IN PULSE?

Deleting a Pulse user removes all access to Pulse and keeps the user information in the Pulse data-
base. To give a user the ability to re-use the email address in Pulse, you must first delete the user
from the dbo.Users and dbo.Login tables in SQL Server. Once the entries are deleted, the email can
be used to create a new Pulse account.
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

Dashboard Admin Guide

Installation Guide for Windows Server 2008

Installation Guide for Windows Server 2008R2

Installation Guide for Windows Server 2012

Upgrading Guide

User Guide

What's New Guide
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